Basic Access 2007 Seminar
# Basic Access 2007 Seminar

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>COURSE INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>RELATIONAL DATABASE</td>
<td>2</td>
</tr>
<tr>
<td>ENTER THE MS ACCESS WORLD</td>
<td>4</td>
</tr>
<tr>
<td>NEW FEATURES</td>
<td>8</td>
</tr>
<tr>
<td>DESIGN A DATABASE</td>
<td>10</td>
</tr>
<tr>
<td>TABLES</td>
<td>11</td>
</tr>
<tr>
<td>QUERIES</td>
<td>17</td>
</tr>
<tr>
<td>FORMS</td>
<td>28</td>
</tr>
<tr>
<td>REPORTS</td>
<td>34</td>
</tr>
<tr>
<td>IMPORT AND EXPORT DATA</td>
<td>36</td>
</tr>
</tbody>
</table>

November 2, 2007 ~ TOC-1 ~
Course Introduction

Seminar Focus
- This is an entry level course for MS Access 2007. Some exposure to databases is helpful but not necessary.

Completion of Session
Remember to LOGOUT before you leave.

For the learning pleasure of all,
and for the sake of your Instructor’s sanity,
please turn off all cell phones,
pagers,
blackberries,
treos, etc.
or put in silent/vibrate mode.
Thank you.
Basic MS Access 2007 Seminar

Relational Database

What is MS Access?
- MS Access is relational database software.

What is a Relational Database?
- A database is a collection of information or data on a specific topic or business application. Databases can be quite large and complex (i.e. Banner, which is a collection of institutional information), large (Student or Employee information), or small (your personal address book).
- A relational database stores common data in tables. The data in each table is related to data in another table. Relational databases reduce redundancy. Example: In an employee relational database, an employee’s name would only be entered once. The employee’s ID number would be used to relate to other employee information in other tables.

Help with MS Access 2007
- Microsoft’s web site has a lot of information on MS Access 2007. The web site is: http://office.microsoft.com/en-us/access/. Help topics and demos are available on the web site. It’s like having a manual at your fingertips.
- If you go to http://www.lehigh.edu/lts/teams/act/, you will find a link to Lehigh’s Microsoft Office 2007 information. On the left side, click on Application and choose MS Access. You will find the link to Microsoft and several other links to helpful web sites.

Database Objects
- The objects with which we will work are tables, queries, forms, and reports.
  - **Tables**
    - Contain the data. Data is contained ONLY in tables.
    - It is displayed, massaged, and summarized in the other objects, but IS NOT stored in those objects. Any action you take in any object to modify your data will modify the data in your tables.
    - Tables have fields that contain your data. During the design phase, you define your fields as to type of data, how data is entered, restrictions on data, and other data properties.
    - Each table has a primary key.
    - A table may also contain what is called a foreign key that relates to information in other tables. This foreign key may be repeated in a table, that is, there may be many rows with the same foreign key value. We will explore this a little more when we talk about relationships.
  - **Queries**
    - Display data from one or more tables.
    - You choose what fields you want in the query.
    - Criteria can be applied to filter out data.

Remember:
If you delete data or change data in a query, you have deleted or changed data in your tables.
There are several types of queries. We will be dealing with the following:

- **Select**: A query that displays data from one or more tables.
- **Append**: A query that appends rows to a table.
- **Update**: A query that updates data in a table.
- **Delete**: A query that deletes rows in a table.
- **Make Table**: A query that makes a table from existing data. It also retains the same characteristics for each field from the source data.

### Forms
- Display data and allow for data entry.
- Data integrity is maintained across tables so you reduce the risk of orphaned records.
- The destination of the data (table) is transparent to the person entering the data.

### Reports
- Display data in an organized and eye-pleasing (if designed well) manner.
- Reports can be printed, saved as PDF files and sent as attachments through email, saved as html files and published on the web, and other options.

**Naming Conventions**

- **Objects**
  - Keep it simple and short, but meaningful.
  - It is advisable not to use spaces in an object name. Use a mixture of lower and upper case or use the underscore.
  - You may further describe the object and its purpose in its properties.
  - The following naming conventions are recommended:
    - Tables: start each name with `tbl`
    - Queries: start each name with `qry`
    - Forms: start each name with `frm`
    - For Sub Forms: start each name either with `sfrm` or `subfrm`
    - Reports: start each name with `rpt`
    - For Sub Forms: start each name either with `srpt` or `subrpt`

- **Fields**
  - As with objects, keep it simple and short but meaningful.
  - It is advisable not to use spaces in a field name.
  - Use a mixture of lower and upper case or use the underscore.
  - In the table design view, you can further document the field.

**Forbidden Names or Words**

- These are also known as Reserved Words.
- These are words that have a special meaning to MS Access or the database engine.
- **Use of these words WILL cause problems in your database.**
Enter the MS Access World

Start MS Access
- Click on the appropriate icon on your desktop or in Programs.
- MS Access has you choose to open an existing database, create a blank database, or create a database from a template before starting the software.
- A list of recently opened databases appears on the right. Your database may be there. If not, click on the open folder icon and browse for your database.
- See Figure 1.

Create a Database
- Click on MS Office Button → New.
- Name your database and select the folder in which to put it. Unlike other software, you must name your database in the beginning and not at the end or part way through as in Word or Excel. See Figure 2.
- MS Access immediately opens a table for you.
  - MS Access will determine the data type by the data entered.
  - To rename the column, you must either right click on the column name, double click on the column name, or go to design view.
  - It is not recommended to design tables in this way as you still need to go to design view to enter field properties.
- Correct table design is very important. Therefore, Design View is recommended.
How to Save Your Database

- Should you save your database in MS Access 2007 format (.accdb) format or in MS Access 2002-2003 format (.mdb)?
- If you save your database in the MS Access 2007 format, it cannot be opened with previous versions of MS Access.
- Here at Lehigh University, conversion from MS Access 2003 to MS Access 2007 will be done by the Computing Consultant team. If you are supported by the ACT team, conversion will be done on a department by department basis.

Customize MS Access

- This is one item that can be hard to find in MS Access 2007. Click on the MS Office Button that doubles as the File Icon. Then click on MS Access Options. See Figure 3.
You will now see groups of items that can be changed. See Figure 4.

- On the **Popular** grouping you can change the color scheme, the Default database folder, and the Default file format.
- On **Current Database**, you can change various options for just this database.
  - The Compact on Close option is in this group. Be careful when choosing this.
  - To manually Compact and Repair, left click on the MS Office Button ➔ Manage ➔ Compact & Repair.

**WHILE IT SOUNDS LIKE A GOOD IDEA TO COMPACT YOUR DATABASE AT EACH CLOSE, AND IT SHOULD BE DONE PERIODICALLY, YOU SHOULD NOTE THAT MS ACCESS MAKES A COPY OF THE DATABASE WHEN IT COMPACTS. THUS, YOU MUST HAVE ENOUGH ROOM ON YOUR MEDIA (HARD DRIVE, LAN, MEMORY STICK) FOR 2 COPIES OF THE DATABASE. IF THE DATABASE IS USED FREQUENTLY BY MORE THAN ONE PERSON, IT IS POSSIBLE FOR MULTIPLE PEOPLE TO HAVE THE DATABASE OPEN SIMULTANEOUSLY. THIS MEANS MS ACCESS WILL COMPACT THE DATABASE WHEN EACH PERSON CLOSES THE DATABASE AND, IF TAKING PLACE ON THE LAN JUST SECONDS APART, MS ACCESS WILL TRY TO MAKE THAT MANY COPIES OF THE DATABASE.**
IN THE COMPACTING PROCESS. THIS CAN CAUSE MAJOR DATABASE PROBLEMS THAT YOU TRULY WANT TO AVOID. THE BEST SOLUTION TO A LAN DATABASE IS FOR ONE PERSON TO BE RESPONSIBLE TO COMPACT THE DATABASE PERIODICALLY.

- On **Customize**, you can customize your Quick Access Toolbar. See Figure 5.

![Figure 5](image1)

![Figure 6](image2)

On **Trust Center**, you can set security settings.

- One setting has already been changed for you at installation. Macro settings are set to the lowest security option. Although Microsoft does not recommend this setting, here within the confines of Lehigh University’s Network protected by firewalls, it is advisable in order for existing databases containing code and macros to be accepted. See Figures 6 & 7.
New Features

Navigation Pane

- All the objects in the database are listed here.
- The Navigation Pane can be closed to provide a larger work area when designing or viewing database objects. To close, simply click on the double arrow pointing left on the top right of the Navigation Pane. Reopen the Navigation Pane by clicking on the double arrows pointing to the right.
- To view the details of the database objects, right click anywhere in the All Access Objects header, go to View By, and choose Details.
- You can expand your viewing space by moving your cursor over the right hand side of the Navigation Pane until it turns into a double arrow, then left click and hold, and move to the right.

If the database in MS Access 2003 had the database window closed, the Navigation Pane will be closed when you open the database in MS Access 2007. This will be a rare occurrence. If someone designs a database with the Navigation Pane closed, it will be closed when you open the database.

Navigation Pane Grouping

- You can choose how to group your objects or even do your own customized grouping.
- MS Access will group by object type, modified date, or created date.
- Another group type is Table and Related Views.
This displays all the objects related to each table.

- It is quite useful for a developer who has made changes in a table to determine what other objects could be affected.

- If you have more than one application in your database, consider grouping by application.

- Grouping actually creates a "shortcut" to your object, so be careful. If you rename your shortcut, you are NOT renaming the original object.

- There are 2 ways to create a custom group(s) for your objects.
  - **First Method**
    - Right click on the top of the Navigation Pane.
    - Left click on Navigation Options.
    - Left click on Custom.
    - Left click on Add a Group.
    - You can rename the group now or later by left clicking on the group name and left clicking on the Rename Group.
    - You can delete a group by left clicking on the group name and left clicking on the Delete Group button.
  - **Second Method**
    - Right click on an object in the Unassigned Objects group.
    - Left click on Add to Group.
    - Left click on New Group.
    - Name the new group and press enter.

- There are 2 ways to add objects to a group.
  - **First Method**
    - Left click on the desired object and drag to the group name.
  - **Second Method**
    - Right click on the object
    - Left click on Add to Group.
    - Left click on desired group name.

- You can also move objects to another group the same way you add an object to a group.
- To remove objects from a group
  - Right click on the object.
  - Left click on remove.

**Ribbon**

- The *Ribbon* replaces the prior version’s toolbars.
- The *Ribbon* contains groups and each group contains a number of controls.
- Additional groups of controls will appear for some *Ribbon* groups.
- Click on the various *Ribbon* groups. When an icon and its name change to color, that option is available, otherwise, it is grayed out.
- Additional options may appear on the *Ribbon* for certain topics. Example: Open a table in Design View. Notice that *Design* now appears on the *Ribbon*.

**Quick Access Toolbar**

- As noted earlier, you can customize your Quick Access Toolbar by adding those icons that you use frequently.
  - Right click on the QA Toolbar.
  - Left click on Customize QA Toolbar.
  - What appears is the same box as in Access Options.
You can change the location of the Quick Access Toolbar. Click on the down arrow on the far right of the Quick Access Toolbar. The 2nd option from the bottom allows you to place the Quick Access Toolbar below the Ribbon. You can also do this in Access Options that was discussed earlier.

You can also make changes by clicking on the More Commands on the dialog box.

**Tabbed Viewing of Objects**

- In MS Access 2003, opened objects overlapped in the database window. In MS Access 2007, they are now tabbed for easier accessibility.
- For those who like the old overlapping windows, you can change this option by going to MS Office Button → Access Options → Current DB. Change the Document Windows Option from Tabbed Documents to Overlapping Windows.

**Change View of an Open Object**

- MS Access opens an object in its normal view option; i.e. for a table, the normal view option is datasheet; for a report, it is print preview. There are 4 icons on the bottom right of the screen, just to the right of “Num Lock”. Use these icons to change the viewing mode of your object.
- This can also be done on the Ribbon. The View grouping is on the far left. *See Figure 8.*

**Design a Database**

**Think First, Then Write**

- Before starting, think through what you want your database to do.
- What data do you want?
- Does the data need to be formatted?
- Does the data need to be limited?
- Will you need repeating tables?
- Will you need validation tables?
- Will you need forms?
- What reports do you want?
Basic MS Access 2007 Seminar

- Take the time to sketch out your reports. It will help you determine what fields you need and how to organize your fields into tables.

Go To Exercise 1

Tables
Definition
- A table is a collection of common data.
- It is the only object that contains data.

Design a Table
- A table is the first object that must be designed. MS Access will not allow any other object to be designed without at least one table in the database. (Which is probably why MS Access opens a table when you open a blank database.)
- Define your fields.
  - Name your fields.
  - Decide how big your fields should be.
  - Determine the type of data each field will have (text, numeric, date).
  - Decide default values.
  - Decide if caption names should be different than the field names.
  - Decide special formatting.
  - You may have up to 255 fields for each record in a table. That’s a lot of data and the table may become unwieldy.
  - A field name can be up to 64 characters and may include letter, numbers, spaces, and special characters except a period(.), an exclamation point(!), an accent grave(‘), and square brackets([]). As noted before, spaces are not recommended. Use of special characters is also not recommended, just for simplicity’s sake.

Taking the time to design your tables and fields properly will help prevent issues such as redesign, format changes, new fields, etc. at a later time.

Data Types
- **AutoNumber**: A unique and sequential number, usually incremented by 1 but it can be randomly (not recommended) assigned by MS Access. An AutoNumber field cannot be manually updated.
- **Numeric**: Numeric data used in calculations. ID’s may also be numeric. Use of auto numbering (see below) for an ID makes the ID numeric.
- **Text**: Letters, numbers, special characters. Numeric data not used in calculations should be a text field. Example: telephone numbers and zip codes.
- **Currency**: Currency values, formats with a $.
- **Date/Time**: Date and time values for the years 100 through 9999. A date/time format can be assigned.
- **Yes/No**: Field can contain only 1 of 2 values. The values stored internally are -1 (Negative One) for Yes and 0 for No.
Memo: Lengthy text field. Use should be limited. Allows from 0 to 65,536 characters.

OLE Objects: An object (i.e. Excel spreadsheet, Word document, graphics or sounds) linked to or embedded in an MS Access table.

Hyperlink: A URL address.

Attachment: New in MS Access 2007, allows an easy way to add pictures, PDF files, spreadsheets, etc. to your database without creating database bloat.

Lookup Wizard: Looks up field values from another table or a list. The wizard steps you through the creation of the field.

- When you have created your look-up field, look for the property called Limit to List. This is a valuable tool. If you leave it at No, any value can be added to the field, even though there is a drop down box. If you change it to Yes, the values are limited to the list.

- It’s not a Data Type but it’s worth mentioning here. You can document the field; it’s purpose, what data it holds, by keying text on the field name line under Description.

Field Properties

- A field also has properties that can be defined to provide more control over the data that goes into the field, how it is displayed, or how it is stored. Properties vary according to data type. These are the field properties we will deal with in this course.
  - Field Size: Sets the maximum number of characters in a field. Allow yourself room in a field. MS Access will only use the space it needs. Example: if you use 10 bytes of a 50 byte field, MS Access will only store the 10 used bytes; it will not store 40 empty bytes.
  - Format: Determines how a field is displayed, such as a date field.
  - Input Mask: A pattern for entering and displaying data, such as a phone number.
  - Caption: The label used for a field on a form or report. If not specified, the field name is used. It is now OK to use spaces.
  - Default Value: Value entered into the field for all new records. May be overwritten as needed.
  - Validation Rule: An expression that limits the value that can be entered. Example: >0<=20
  - Validation Text: Message that pops up when validation rule is violated.
  - Required: Data must be entered into this field or the record cannot be saved.
  - Index: Have MS Access use this field as an index. An index is in an internal sort order that helps MS Access find and sort records faster. If you choose to index the field, you must determine if you will allow duplicates or not. Choose allow duplicates for repeating tables. It is recommended to index any field that will be used frequently in queries or frequently in sorts in reports.

Go To Exercise 2

Create a Table

- Click on Create on the Ribbon. The Ribbon shows 4 sets of icons: table creation options, forms creation options, report creation options, and other options (queries and macros).
- For tables, there are 4 options.
Unless you need to do something very quickly, Design Mode is recommended as you have more control over your table design from the start.

Add Records to the Table
- Open the table in datasheet view by double clicking on the table name.
- An * in the last row of the table indicates that the new record starts there.
- You may also click on the >* on the navigation indicator, as well as click on the “new” icon in the records grouping on the Ribbon.
- Enter data and use the tab key to move to the next field. Note: You cannot enter data in an AutoNumber field. Just tab over and a value will automatically show.

Go To Exercises 3 and 4

Search for a Record in a Table
- Click in the field you wish to search and Click on the binoculars.
- A dialog box appears.
  - Enter text to search on.
  - You may change the field to search by clicking on the drop down arrow for “Look In”.
  - You may change how to match; options are Whole Field, Part of the Field, or Start of the Field.
  - You can search all records, or up or down from where your cursor is.

Go To Exercise 5

Delete Records From a Table
- To delete a record, highlight the record by moving your cursor to the left of the record and left click.
- Either press the delete key on your keyboard or click on the delete icon in the records grouping on the Ribbon.

Modify Records in a Table
- Left click in the field.
- You can highlight the entire contents of the field and over write the old contents.
- You can highlight the contents, delete by pressing the delete key on your keyboard, and enter the new data.
- You can place your cursor at the point you wish to make a change and change the data.

Go To Exercises 6 and 7

Filter Records in a Table
- Filtering allows you to specify criteria to decrease the amount of records displayed.
- Place your cursor in the field that contains the value you wish to use.
- Click on the Selection Icon in the Sort and Filter group on the Ribbon.
- You now have more choices; click on the one you want. See Figure 9.
You can also filter by using the Filter icon that looks like a funnel. Click on the field you wish to filter, and then click on the large Funnel Icon in the Sorting and Filtering group on the Ribbon. See Figure 10.

Once you have applied the filter, you will see the word “Filtered” on the bottom right and along the navigation bar. To remove the filter, click on the Toggle Filter icon.

Sort Records in a Table

To sort records, place your cursor in one of the fields, click on either of the sort icons, ascending or descending.

Go To Exercises 8 through 10
Modify Table Design

- A table’s design can be modified even after data is entered. Highlight the table name in the Navigation Pane. Right click and choose Design View.
- An alternative way is to first open the table. On the Ribbon, the Views grouping will now be available. Click on Design View.
- Some words of caution when changing a table design.
  - If you decrease the text size, MS Access will warn you that you may lose data. Make sure your new text size still captures all your data.
  - If you have leading zeros in a text field and change the field to numeric, you will lose the leading zeros; i.e. 08457 becomes 8457.
  - Once records are entered into a table, you cannot change a field to AutoNumber.

Go To Exercises 11 & 12

Table Relationships

Types of Table Relationships

- One-to-one
  - For every record in the first table, only one record exists in the second table. Typically, data in the second table would be included in the first table. There are several valid reasons for keeping some of the data separated, security is one; ease of use, another.
  - Link is the primary key in both tables.
- One-to-Many
  - Also called parent-child or master-detail.
  - For every record in the parent or master table (one table), there are zero or more records in the child or detail table.
    - Why is zero record an option?
      - In our club application, a club member may be on no committees, on one committee, on two or more committees. If on no committees, that club member would have no records in tblCommittee.
  - Link is the primary key in the parent table and a foreign key in the child table.
- Many-to-Many
  - Each record in the first table could be related to zero, one, or many records in the second table and each record in the second table could be related to zero, one, or many records in the first table.
  - This is a complex situation, only those with no fear should tread into the many-many world.
  - See Figure 11.
- To see Relationships, Click on Database Tools, then Relationships in the Show/Hide Group.
- To create a relationship, Left Click and hold on the first field desired and drag on top of the second field desired. When you release, a box called Edit Relationships appears. See Figure 12.
- Click on create to establish the relationship. (Note how MS Access defines the type of relationship at the bottom of the dialog box.)
Referential Integrity

- Keeps records synchronized in your tables so you don’t have records in one table referencing records that no longer exist in another table, also called Orphan Records.
- Example:
  - We deleted Michael Vick from tblSemMaster. If we had deleted him from tblClubMaster, orphan records would have been created in tblClubDues and tblCommittees if referential integrity were not turned on for these table relationships.

- It’s a good thing to set this when you design tables and before you start entering data.
- To do so, go to Database Tools on the Ribbons, click on the Relationships Icon.
- To set Referential Integrity between two tables, right click on the line that establishes the table relationship, left click on Edit Relationship.
- The Edit Relationship Box appears. See Figure 12.
- Check the box “Enforce Referential Integrity”.
- Three rules now apply to your data.
  - A record must exist in the Master Table (record with a Primary Key) in order to add a record with a foreign key to a related table.
  - You cannot delete a record in the Master Table if there are related records in other tables unless Cascade Delete Related Records is also turned on.
  - You cannot change a primary key value if it will create orphan records in other tables unless Cascade Update Related Records is turned on.

Cascade Delete Related Records

- If this option is set, MS Access will delete all records in all tables when the record in the Master Table is deleted.
- To set this value, bring up the Edit Relationship Box just as if you were going to set Enforce Referential Integrity.
- Check the box marked Cascade Delete Related Records.
Cascade Update Related Records

- If this option is set, MS Access will update all records in all tables when the primary key record in the Master Table is changed.
- To set this value, bring up the Edit Relationship Box just as if you were going to set Enforce Referential Integrity.
- Check the box marked Cascade Update Related Records.

Queries

Definition

- The query is one of the most useful tools in MS Access.
  - You can link tables and/or queries together and see more data than what exists in just one table.
  - You can apply more criteria than in table filtering to display selected records.
  - A query enables you to view, change, delete, append, and analyze your data in many ways.
- The same searching and filtering techniques you learned with tables apply to queries also.
- Search, filter, and sort are more powerful in queries and therefore more useful.
- A query may also serve as a record source for a form or report.
- You must have at least one table in your database in order to create a query.

Types of Queries

- Select Query
  - This is the most common type of query.
  - A select query retrieves data from one or more tables or queries or a combination of table(s) or query(ies) by using criteria you specify and displays data in the order you desire.
  - You can perform calculations.
  - You can also group records and perform calculations.
• **Parameter Query**
  - A parameter query displays a dialog box prompting you for criteria to run the query.
    - For example, a student class list query may prompt you for the name of the class. Thus, a parameter query can display class lists for many classes thereby eliminating the need to have a query for each class or to modify your query design.
  - MS Access 2007 takes this capability a step further and allows filtering directly in a report and eliminates the need for some parameter queries.

• **Action Query**
  - This type of query makes changes to records in your tables.
  - Once an action query is run, you cannot undo the result by clicking on the undo icon.
  - MS Access gives you the capability to preview your results before actually running the action.

• **Delete Query**
  - Deletes records from a table.
  - You can choose to delete all the records or just records based on criteria. The entire record is deleted and is gone forever.
  - Be very careful with a delete query.

• **Append Query**
  - Appends records to a table.
  - One or more tables or queries are used as the source for an append query.

• **Update Query**
  - Updates fields in a table.
  - An update query is quite useful when a table has hundreds of records that must have one or more fields updated.
  - Criteria can be applied to update only certain records.

• **Make Table Query**
  - Creates a new table from one or more tables or queries.
  - A make table query will take longer to run than an append query because it builds the table with all the existing field properties as they exist in the source tables.

**Create a Query Using a Wizard**
- Click on the “Create” tab on the *Ribbon*.
- Clicking on Query Wizard displays the old familiar options.
  - **Simple Query Wizard**: Leads you through the steps to create a simple query.
  - **Crosstab Query**: Displays data in a compact spreadsheet fashion.
  - **Find Duplicates Query Wizard**: Finds duplicate values in a field with a table or query.
  - **Find Unmatched Query Wizard**: Finds all records in one table that do not have a match in another table.
- Clicking on Query Design opens the manual design for a query. Unlike MS Access 2003, MS Access 2007 also automatically shows the tables and queries from which to choose a data source for your query.
Basic MS Access 2007 Seminar

Query Wizard
- The wizard leads you through the creation of a query by having you select the basic elements.
- Select the source table or query.
- Select the fields desired and click on next.
- Now choose if you want every record or a summary. A summary will allow you to calculate sums, averages, minimum value, and maximum value.
- When you continue through summary options, you can choose how to group your data, click next.
- Name your query. Remember the naming conventions. If you do not name your query, MS Access will name it for you with its own naming convention. (It is not a pretty sight!)

Go To Exercise 13

Create a Query Using Design View
- Unlike MS Access 2003, MS Access 2007 automatically displays the Show Table dialog box.
- Choose the desired tables and queries and close the Show Table dialog box.
- The upper part of Design View is the table/query entry pane.
- The bottom part of Design View is the design grid.
- To add a table or query, either double click on the object name or left click and drag the object to the entry pane.
- To remove a table/query, simply left click somewhere on the table/query and press delete on your keyboard. An alternative method is to right click on the table/query and left click on “Remove Table”.
- If you need to add a table or query to the query after you have closed the Show Table dialog box, right click on any empty space in the entry pane, and left click on “Show Table”.
- You can switch between panes by using F6 or clicking in the pane desired.
- Notice links. MS Access will automatically establish a link between the tables/queries if it sees a common field name in both tables or you have already established a relationship between two tables.
- Create your own links whenever access has not created one for you. This could happen if the ID is called IDNum in one table and ID in another. To create a link, left click and hold on the first field, drag your cursor to the field in the next table or query and release.

Understanding the Design Grid
- There are 5 lines in the design grid: field, table, sort, show, & criteria (multiple lines)
- **Field** is the field name to display.
- **Table** is the table name from which the field came.
- **Sort** is for the sort option, ascending, descending, or not sorted.
- **Show** is to choose to display the field or not. If the box is not checked, the field will not display when the query is run.
- **Criteria** are used to filter data.

Add Fields to a Query
- There are 4 ways to add a single field to the design grid.
  - Double left click on the field name. It will be added to the end of the field list.
Basic MS Access 2007 Seminar

- Left click and drag. It will be added wherever you choose.
- In Field, click on the down arrow and choose a field from the drop down list.
- Key the field name into Field line.

- To add multiple fields to the design grid.
  - Hold the Control key and left click on the desired field names. Left click and drag the field names to the design grid. If the fields are contiguous, use the Shift key and not the Control key.

- To add all the fields from a table or query to the design grid.
  - Highlight all the fields and drag them to the design grid.
    - Double left click on the asterisk and all the fields will be added to the design grid. Notice that MS Access adds them as a group with the table name preceding the asterisk.

See the Results of a Query

- On the furthest left portion of the Ribbon, you will see 2 icons; View and Run. For a select query, either will give you the same results.
- For action queries, be cautious.
- View will show the results of the action query without actually performing the action query, i.e. a preview.
- Run will perform the action query.
- There is no going back once an action query has been run. Fortunately, MS Access makes you Confirm Action Queries and gives you a chance to escape without damage. The Confirm Action Query can be turned off in MS Access Options (Advanced, under Confirm). It is not recommended to do so.

Delete a Field from a Query

- Move your cursor to the small grey area just above the Field line. The cursor will change to a black down arrow. Left click and the entire column background turns black. Press the delete key on your keyboard.
- Right click on the field name, left click on cut.

To Move Fields Within the Query

- Move your cursor over the field name until it becomes a white arrow. Left click and hold. The column background will turn black; you can then move the field to the right or left as desired.

Resize Columns

- Resize the columns just as you would in Excel.
- Move your cursor to the right of the field name until it turns into a black cross with arrows on the vertical line. Move to the left to make your column smaller, move to the right to make it bigger. Alternatively, you may double left click to expand the column to its maximum needed width.

Field Alias

- Some field names, especially in Banner, may be quite long. To simplify your query, you can create an alias for the field name. The alias does not affect the name of the field in the underlying table.
- An alias can also be created to combine the contents of 2 or more fields. This is commonly done with name and address fields (especially city, state, zip).
- To create an alias, simply click to the very left of the field name. Key in the alias and add a colon (:).
- Example: Rename field, LastName, to Last.
Basic MS Access 2007 Seminar

- Last: [LastName]

**Concatenation of Fields**

- You may wish to display several fields as one. A common application is using one field to display a name instead of the common three fields (last name, first name, middle initial).
- Concatenation is not an ominous task, but you must be perfect in your syntax.
- The “formula” is simple. The concatenation symbol is the “&”. You must account for all punctuation, including spaces. Text is surrounded with double quotes, punctuation and spaces are considered text. Database fields are surrounded with square brackets, [].
- Example: To concatenate three fields into one field called ClubName with the three fields called LastName, FirstName, MI, the following would show in the field name of the design grid:
  - ClubName:[LastName]&”, “&[FirstName]&” “&[MI]

**Sort**

- MS Access sorts fields as they appear from left to right in the design grid.
- To sort, left click on the Sort line under the field you wish to sort. Choose Ascending or Descending or Not Sorted.
- With a query, you can sort as many fields as needed. Just remember, MS Access sorts left to right only.

**Criteria**

- The criteria lines allow you to select only the data you want.
- All criteria on the same line creates an “and” condition, that is, all criteria must be met for the data to display.
- Subsequent lines create “or” conditions. If you use 2 lines of criteria, your data must satisfy all the conditions on the first line OR all the conditions on the second line.
- Characters like “<” or “>” or “=” are useful in creating criteria.
- Another useful criteria is “Between”.
  - The syntax is Between 1st value and 2nd value.
    - Between 3 and 10 is the same as >= 3 and <= 10.
    - Between 09/01/2007 and 10/31/2007 is the same as >= 09/01/2007 and <= 10/31/2007.
- Wild Card.
  - The wild card in MS Access is the asterisk (*) and may appear in the beginning, the end, or both, or in the middle.
  - The wild card simply means any data that meets the partial requirement is acceptable.
  - Example in using a last name field:
    - Smit* will return all last names that start with Smit; such as Smith, Smithers, Smithson, Smitters
    - %son will return all last names having “son” at the end; such as Johnson, Peterson, Jacobson.
    - *ent* will return all last names that contain “ent” anywhere in the name, such as Entermann, Menthol, Pepperment.
    - Ca*ton will return all last names that start with “Ca” and end with “ton”, such as Carlton, Casleton, Camelton, Cashton.

**Parameter Query**

- A parameter query prompts the user for information before running the query.
Basic MS Access 2007 Seminar

- This allows one query to be used for several inquiries.
- The text for the prompt is places on the criteria line, under the field name for which you are selecting, and within square brackets, [].
- Run the query and see what happens.
- Results should show just that committee’s membership.

Parameter Queries and the Wild Card
- It’s a little tricky but the Wild Card can be used in parameter queries.
- The criteria must be set up with the wild card.
  - Like “*”&[Some wording]&“*”

Go To Exercises 13 Through 28

Crosstab Query Wizard
- A crosstab query is useful for data analysis.
- It calculates a sum, average, record count, or total for data that is grouped by two types of information; one down the left side of the datasheet and one across the top.
- The wizard leads you through all the steps necessary to create this type of query.

Go To Exercises 29 & 30

Find Duplicates Query Wizard
- This query finds all duplicate field values in a single table or query.
- The wizard leads you through all the steps necessary to create this type of query.
- MS Access 2007 will name the query something long and bulky if you do not name it. However, if you do not intend to keep the query and have used it just to trouble shoot your data, then it doesn’t matter what it is called.

Go To Exercise 31

Find Unmatched Query Wizard
- This query finds records in one table or query that have no related records in another table or query.
- Sometimes there will be no matching record in the parent table for a record in a child table.
- This situation is called having orphaned records and can be avoided by using forms to properly maintain data and by correctly maintaining your relationships between tables.
- The wizard leads you through all the steps necessary to create this type of query.
- MS Access 2007 will name the query something long and bulky if you do not name it. However, if you do not intend to keep the query and have used it just to trouble shoot your data, then it doesn’t matter what it is called.

Go To Exercise 32

Time to Organize
- Your exercise results currently exist in the Unassigned Area.

Go To Exercise 33

November 2, 2007 ~-22~
Query Joins

- A query is more useful when more than one table is used.
- MS Access will automatically create inner joins or equi-joins whenever it sees fields of the same name in different tables or you have established a table relationship.
- Field names do not have to be the same but they must be the same data type to be joined.
- If you set up your relationships when you do your table design, your query joins will be done.
- To create a join, left click and hold on the field in the first table and drag to the corresponding field in the second table. The fields are now joined.
- To delete a join, right click on the thin black line of the join, a dialog box should appear with 2 options, left click on delete and the join disappears.
- Inner Join or equi-join.
  - All records in both tables are selected whenever the value in the joined fields is the same.
  - Records that do not match on the joined fields are excluded from the query.
- Outer Joins.
  - There are 2 types of outer joins; right and left.
  - The join line differs from an inner join in that it is an arrow. The base of the arrow lies in the first table, the arrowhead in the second table.
  - For a left join, all records in the left table (arrow base) will appear in the query and only those records that match in the right table will appear in the query.
  - For a right join, all records in the right table (arrow base) will appear in the query and only those records that match in the left table will appear in the query.
- To change a join, right lick on the thin line creating the join, a dialog box will appear. Left click on join properties and choose the desired join.
Example of an Inner Join: All records will be displayed for each IDNum in tblClubMaster who have a record or more than one record in tblClubDues. See Figures 13 & 14.

Figure 13
Results of the inner join.

Figure 14
Number of records = 88
Example of a left outer join: All names will be displayed from tblClubMaster even if the club member has not paid dues. *See Figures 15 & 16.*

**Figure 15**

Results of the left outer-join.

**Figure 16**

Number of records = 90
Example of a right outer join: All records from tblClubDues will display even if there is no record for that person in tblClubmaster.  See Figures 17 & 18.

Note the direction of the arrow.

Results of right outer-join.

Number of records = 88
Grouping

- You may need to group your records to calculate totals, get record count, compute an average, or find the maximum or minimum value in the field. BEAR IN MIND THAT NOT ALL CALCULATIONS WILL REQUIRE GROUPING!
- For this you will use the Greek symbol Sigma that appears under Design on the Ribbon and in the Show/Hide grouping.
- Click on this with an open query and another line appears in the Design Grid called Total.
- Click somewhere on that line under amount paid and you will see the various options available. See Figure 19.

Figure 19

Go To Exercise 34

Action Queries

- Action queries enable you to automate some procedures.
- The larger the database the more time it takes to make massive changes.
- View an action query, views the results without performing the action.
- Run an action query performs the action.
- When you run an action query, MS Access gives you one last chance to bail out. A dialog box appears telling what is about to happen and asking if you really want to do it. Once you respond “Yes”, there is no going back.

Once an Action Query is Run, It Cannot Be Undone. Test, Test, and Test Your Action Query!
Test an Action Query
- The easiest way to test an action query is to make a copy of the table or tables involved.
- If you get the desired results, then you are ready to make your action query “Go Live”.
- To make a copy of an object: Click on the Office Button, Click on File Save AS, Name the Object.

Delete Query
- You can delete either all the records in a table or some of the records in a table.
- Selection criteria, just as we used in the Select Queries, controls what records get deleted.
- Turn the select query into a delete query by clicking on the Delete Query Icon in the Query Type grouping.
- To delete all records in a table, drag the * to the design grid.

Append Query
- With an append query, you can append or add records to your table.
- The source for an append query may be another table or a query.
- Selection criteria, just as we used in the Select Queries, controls what records get appended.
- Turn the select query into an append query by clicking on the Append Query Icon in the Query Type grouping.

Update Query
- With an update query, you can make massive changes in just seconds.
- Selection criteria, just as we used in the Select Queries, controls what records get updated.
- Turn the select query into an update query by clicking on the Update Query Icon in the Query Type grouping.
- In the Update To line in the design grid, key exactly what the new value should be.

Make Table Query
- This will make a new table from the data specified.
- Selection criteria, just as we used in the Select Queries, controls what records and fields are used to create the new table.
- Turn the select query into make table query by clicking on the Make Table Query Icon in the Query Type grouping.

Go To Exercises 35 Through 40

Forms

Definition
- Provides the means to: Display Data, Enter Data, Create a Switchboard or A Custom Menu or Custom dialog box.
- To create a form, click on the Create tab on the Ribbon.
- When you click on any of the form options, other tabs will appear. What tabs appear depends on which form option you chose.
- The additional two tabs contain a lot of our old favorites such as aligning, field sizing, field list, property sheet, buttons, etc.
- Most forms are bound to one or more underlying tables or queries.
- Not all fields from the table(s) or query (ies) need to exist in the form.
Adding data or editing data in the form changes the field value in the underlying tables.

Several forms can be designed immediately at the click of the mouse: Form, Split Form, Multiple Items, Pivot Chart, and Blank Form.

The Form Wizard leads you through each step to create a form.

Form Views

The different form views available can be seen in the View group on the Design tab as well as on the bottom right of your screen. The ones we will use are: Form, Datasheet, Layout, and Design.

Creating Forms With a Wizard

To create a form with any of the wizards, first highlight a data source (any object will do: table query, form, report), then click on the More Forms icon, followed by the Form Wizard icon.

If a form or report was used as the data source, MS Access simply uses the same data source for the new form.

Form Design

In Form Design, MS Access opens a grid.

The grid size can be changed at any time.

Some forms you design may be small, like forms for sub forms. Others may be larger as you create a base form and several sub forms.

To resize, move your cursor to the bottom or the right edge, whichever way you want to resize, watch for the cursor to change to a plus with arrows in the vertical line; left click and hold and resize your form.

Define Record Source

Click on the Add Existing Fields icon in the Tools group.

A dialog box of all the tables appears. See Figure 20.
To add a field, either double left click or left click and drag.
You will notice that the list of available tables and queries and their associated fields has changed.
Look carefully at the text in the box. The lower box lists only those tables that are associated with the fields you just picked. See Figure 21.
Close the box when you have finished selecting your fields.

Alternative Method
Choose a Record Source by right clicking on the square directly to the left of the ruler.
Left click on Properties and a Property dialog box appears.
• Left click on the down arrow on the record source line.
• Choose a table or query.
• *See Figure 22.*

**Figure 22**

**Type of Controls**
- Controls can be bound, unbound, or calculated.
- A bound control is bound to a field name in a table.
- An unbound control does not update fields but retains their value. Examples are line, rectangle, or a picture that is only stored on the form.
- A calculated control is based on expressions and like unbound controls, they do not update fields.

**Working with Controls**
- A control is any object on a form; i.e. a picture, a text box (field), a label, combo box, etc.
- To move a text box with its label, click anywhere in either box. A 4-way arrow appears and you can move the two items to where you’d like.
- To move a text box without its label, move the 4 way arrow to the left most top of the field. In MS Access 2003, the 4 way arrow would turn into a pointed index finger. This no longer happens. But when you move the 4 way arrow to that spot, you will move only that text box or label.
- To change the color of a control, click on that item and choose your text color, background color, font size, and/or font.
- To change the color of a group of controls, draw a box that encompasses all of them, pick your text color, background color, font size, and/or font. *Note: the box need only pass through a small portion of the control or label to be selected.*
- To align a group of controls, select all by drawing a box around the group, click on the Arrange tab on the Ribbon, click on the appropriate direction in the Control Alignment group (left, right, top, bottom).
To resize a group of controls to the same size, select your grouping by drawing a box around the group, click on the Arrange tab on the Ribbon, click on the appropriate icon in the Size group (narrowest, widest, tallest, shortest).

Conditional Formatting
- You can change the format of a control based on the field value.
- Open the form in Design View and click on any bound control.
- On the Ribbon, Click on design and click on Conditional Formatting.
- Choose the value and font desired.

Form Header/Footer
- To add a Form Title, go to the Design tab on the Ribbon, click on the xyz icon or title icon in the Logo group.
- You now see a Form Header and Form Footer on your form. A text box will appear on the form header for you to fill in your text. If you do not like the color, font, or font size, you can change them.
- Tip on “Centering” your title of your form. Resize the title box to the width of your form, and then click on the center icon in the Font group of the Design tab.

Property Sheet
- Each control, each section, and each form has a property sheet.
- To access the property sheet, right click on the control, section, or form.
- Some useful Form properties: Record Source, Navigation Buttons, Scroll Bars, Dividing Lines.
- Some useful Control properties: Can Grow, Color, Format, Special Effect, Enable, Locked, Tab Stop.

Go To Exercise 43

Filter Data
- Just as you could filter data in a table or query, you can also filter data in a form.
- Highlight the data you wish to filter.
- Click on the filter icon in the Sort and Filter group on the Home tab.
- A pop up box appears. Choose your criteria.
- Click OK.

Attachment Manager
- On a form, right click on the field text box (not the label box).
- A dialog box called Attachments will appear. See Figure 23.
- Any existing attachments will be listed.
- To add more, click on Add and browse to the folder where your new attachment resides, Highlight the file with a left click, and Click on Open.
- Your attachment will now appear in the dialog window. See Figure 24.
- Changes made to an attachment will not be reflected in the database attachment.
- MS Access will sort the attachments alphabetically and display the icon associated with the first attachment.

Go To Exercise 44 Through 46

November 2, 2007 ~32~
Sub Forms

- Sub forms are a way to handle those one-many situations.
- A sub form is created exactly like a regular form but is added to another form.
- A form can have more than one sub form.
- You can display all sub forms on the main form or use a tab format.
- To add a sub form, open the main form in Design View.
- Click on the sub form icon.
- On the main from, click where you want to place your sub form.
- A dialog box will appear.
Choose your sub form from the list. The next dialog box will ask how you want to link your parent-child forms. If you cannot read or understand what MS Access proposes, choose Define my own, and pick the fields from each form on which to link.

Go To Exercises 47 & 48

Reports

Definition

- Report Types
  - Report: Uses the current table or query as its record source.
  - Labels: Label wizard to create any type of labels.
  - Report Wizard: Leads you through the steps to create a report.

Create a Report Using Wizards

- To create a report, click on the Create tab on the Ribbon.
- Just as with Forms, you can use the Wizard to create a report, and then go into Report Design.

Labels

- Labels are easy to create through the label wizard.
- Mailing labels are usually the first type of label thought of but other types of labels are also possible.
- The label wizard leads you through each step.
- When you create your prototype label, you must add spaces and punctuation of desired.

Go To Exercises 49 & 50

Quick Report

- You can do a quick report using one table or query as the record source.
- Highlight the desired table or query in the Navigation Pane.
- Click on Create.
- Click on Report in the Report Group.
- A report will appear in Layout View. You may now make changes to the design in Layout view or you can go to Design View and make changes.

Go To Exercise 51

Report Wizard

- Click on Create.
- A dialog box appears in which you choose your record source (table or query) and the fields from that record source.
- The Report Wizard will lead you through the steps.
- Choose your sort option(s).
- New in MS Access 2007 is the Summary Options.
Basic MS Access 2007 Seminar

Go To Exercise 52

Blank Report vs. Report Design
- Blank report opens a new report in layout; report design opens a new report in design view.
- For those quite familiar with design view, layout view takes some getting used as you see all your data as you design your form.
- When you choose either of these options, you will see 3 new tabs on the Ribbon; Format, Arrange, and Page Setup.

Go To Exercise 53

Report Design
Page Setup
- Choose your paper size, print orientation, set margins.
- If you don’t like working with the icons provided, click on the printer icon (Page Setup) and you will see the familiar dialog box for setting up a page in MS Access.

Design
- Design is packed with options.
- Here you have your font controls, gridlines control, grouping & sorting, property sheet, page numbering, report header/footer, and the familiar icons from the design toolbar.

Arrange
- Here you find alignment controls, resizing controls, tab order as well as some auto format features.
- There is a logo feature. This will add a logo or picture only to the Report Header. If you wish to add a picture to the report, use the Image icon under the Design tab.

Controls
- Adding controls, manipulating controls, aligning controls, resizing controls work the same as in Forms.
- To change the properties of a control, right click on the control, then choose properties.
- One interesting property of a control is the Can Grow property.
  - Setting this property to yes means the control will expand to the next line or more, if needed, without any additional programming.

“Green-Bar” Effect
- Remember the old green-bar paper of yesteryear?
- It is now easy to get this effect on your MS Access reports.
- This works best with reports where line or grouping takes the same amount of lines.
- Open rptBirthdays in Design View.
  - Click on the rectangle on the ruler next to the Detail section.
  - In the font group of the Ribbon, click on the Alternate Fill/Back Color icon (just below the back fill icon).
  - Choose a color.
  - View the report.

Filtering
- You can now filter out data directly in a report.
- This option may replace some reports based on parameter queries.
- It is not a good idea to use the filter with large databases.
Example

- In our club database, a report can be designed to list the members of each committee.
- A filter can be applied to choose one or several clubs for printing; no parameter query needed

Open rptCommittees.

- Click on one of the committee names in the report and the filter icon becomes available.
- Choose as many committees as you want or as few as you want.
- Your report is now filtered to print only those committees.

Label Box vs Text Box in Form Design

- A label box is text that you add or a box that describes a field.
- A text box is a table field (bound field as it is bound to a data source).
- A text box can also be used to concatenate fields. Concatenation is done the same way as we did it in the query.

Go To Exercise 54

Sub Reports

- Sub Reports provide for that one-many situation.
- Just like with forms, you add a sub report to a main report.
- The sub report is typically based in a repeating table or query (the foreign key has multiple entries).
- The sub report shows all values for the club member.

Go To Exercises 55 & 56

Import and Export Data

What is Importing and Exporting of Data?

- There will be times when you need to create a table from a spreadsheet, a text file, or some other type of file. You may also wish to export the results of a query or report to another type of file.
- MS Access 2007 makes this even easier. Just as in MS Access 2003, you can save your specifications, but in MS Access 2007, they are much easier to find.
- The External Data tab is where you start for all your Import/Export needs.

Import Data

- You can import from another database, a spreadsheet, a SharePoint list, a text file, html file, rich txt, ODBC source, Paradox, Lotus, dbase, and Outlook.
- The most common import will be from a spreadsheet or a text file.
- You may also want to link to other tables (usually Banner). The data itself is not imported to the database, but it is accessible.
- We will look at imports from another MS Access database, a spreadsheet, and a text file.

Import from Another Database

- You can import any object from another MS Access database.
- If the object name already exists, MS Access will simply add a sequential number behind the name, starting at 1.
Click on the External Data tab and Click on Access.
A large dialog box will appear. You can now browse through your computer to find the database. When found, Click on OK.
A dialog box appears listing all the objects in the database.
Select the ones you want and Click OK.
You will now be prompted to save the import specifications, if you so desire. Click on Save Import to save your specs.
Name your import and add a description.

**Link to a Table in Another Database**
- Click on the External Data tab and Click on Access.
- Browse through your computer to find the database.
- Check the box next to Link to the data source by creating a linked table and Click OK.
- A dialog box appears listing all the tables (tables are the only database objects to which you can link) in the database.
- Select the ones you want and Click OK.
- Check in the Navigation Pane for the table or tables.

**Linked Table or Import table**
- How do you tell the difference between a linked table and a copied table?
- The linked object will have a little blue arrow at the upper left of the icon.
- A copied object becomes another object created in the database.

**Import from a Spreadsheet**
- To make it easy to get data from a spreadsheet into a table, the spreadsheet should be in a columnar format.
- The data types should be the same between the spreadsheet and the existing MS Access table, if the data is going into a new table.
- Click on External Data, then on Excel.
- You will a similar dialog box as when you clicked on Access.
- Browse to get your spreadsheet, left click to highlight your spreadsheet, then left click on Open.
- You now have three options, choose one, and click OK.
  - Import the spreadsheet to a new table.
  - Append the data from the spreadsheet to an existing table. (Be cautious here, field type (text, numeric) must match.
  - Create a linked table to the spreadsheet.
- The wizard will now show the data from the worksheets. Pick your worksheet and Click Next.
- Click the box if you have column headings, the column headings will become field names, Click Next.
- With this next box, you can change the data type, skip the field, or index the field.
- When done Click Next.
- Add a Primary Key and Click Next.
- Name the table and Click Next.
- Save and name the specs if desired.

**Import from a Text File**
- The two most common types of text files are fixed width and delimited.
- The most common types of delimited are comma delimited and tab delimited.
Comma delimited may run into a problem. Can you think of an example? Here’s one I ran into many years ago. The birthday was in the format: month day, year. The comma between day and year wreaked havoc for the import. Sometimes a % sign is used as a delimiter instead of a comma.

If the data in the text file is not compatible with the table, it is easier to make a new table with the text file and use that table to append the existing MS Access table.

Go To Exercises 57 through 60

Export Data
Export to Another Database
- Highlight object to export. Only object can be exported at a time.
- Click on More and Click on Access.
- Browse for the destination database and Click OK.
- Note that for a table you have the option to export just the table definition or the definition with the data. Click OK.

Export to a Spreadsheet
- Highlight the object to export and Click on Excel in the Export Group.
- Browse to the destination folder, check any boxes desired, and Click OK.
- View results and Save Export Specifications, if desired.

Export to a Word File
- Highlight the object to export and Click on Word in the Export Group.
- Browse to the destination folder, check any boxes desired, and Click OK.
- View results and Save Export Specifications, if desired.

Export to a Text File
- Highlight the object to export and Click on Text in the Export Group.
- Browse to the destination folder, check any boxes desired, and Click OK.
- View results and Save Export Specifications, if desired.

Export to an HTML File
- Highlight the object to export and Click on Text in the Export Group.
- Browse to the destination folder, check any boxes desired, and Click OK.
- View results and Save Export Specifications, if desired.

Go to Exercises 61 through 65

Import/Export Specifications
- Take a look at both.
- Are all your saved specifications in each?
You have successfully finished the inaugural Basic Access 2007 Seminar.